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Chapter 370

Mixed Models Tests for
Interaction in a 2×2
Factorial 2-Level
Hierarchical Design
(Level-2 Randomization)
Introduction
This procedure calculates power and sample size for a two-level hierarchical mixed model in which clusters of
subjects are measured one time (cross-sectional) on a continuous variable. The study uses a two-by-two factorial
design with two binary factors, each with two possible values (0 and 1). This results in four treatment arms. The
goal of the study is to test the significance of the two-way interaction between the two factors.
In this two-level hierarchical design, the subjects are the level-one units and the clusters are the level-two units.
All subjects in a particular cluster receive one of four possible treatments. Each treatment is a different
combination of the two interventions.

Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 5, section 5.5.1, pages 167-170. The
hierarchical mixed model that is adopted is
𝑌𝑌𝑖𝑖𝑖𝑖 = 𝛽𝛽0 + 𝛿𝛿𝑋𝑋(2) 𝑋𝑋𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑍𝑍(2) 𝑍𝑍𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑋𝑋𝑋𝑋(2) 𝑋𝑋𝑖𝑖𝑖𝑖 𝑍𝑍𝑖𝑖𝑖𝑖 + 𝑢𝑢𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖

where
𝑌𝑌𝑖𝑖𝑖𝑖

is the continuous response of the jth subject in the ith cluster.

𝛿𝛿𝑋𝑋(2)

is the treatment effect of X.

𝛿𝛿𝑍𝑍(2)

is the treatment effect of Z.

𝛽𝛽0

𝑋𝑋𝑖𝑖𝑖𝑖

is the fixed intercept.

is an indicator variable that is = 1 if cluster i is assigned to receive the X intervention and 0
otherwise.
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𝑍𝑍𝑖𝑖𝑖𝑖

is an indicator variable that is = 1 if cluster i is assigned to receive the Z intervention and 0
otherwise.

𝑢𝑢𝑖𝑖

is a random effect term for the ith cluster the is distributed as 𝑁𝑁(0, 𝜎𝜎𝑢𝑢2 ).

𝛿𝛿𝑋𝑋𝑋𝑋(2) is the interaction effect of X and Z. In terms of the four group means, this effect is equal to
(𝜇𝜇1,1 − 𝜇𝜇1,0 ) − (𝜇𝜇0,1 − 𝜇𝜇0,0 ).

𝑒𝑒𝑖𝑖𝑖𝑖

is a random effect for the jth subject in the ith cluster that is distributed as 𝑁𝑁(0, 𝜎𝜎𝑒𝑒2 ).

𝜎𝜎𝑒𝑒2

is variance of the level one (subject) random effects.

𝜌𝜌

is the intraclass correlation (ICC). This is the correlation between any two level-1 units within a
specific level-2 unit.

𝐾𝐾0,1

is the number of level-2 units for which X = 0 and Z = 1.

𝜎𝜎𝑢𝑢2

𝜎𝜎 2

is variance of the level(cluster) random effects.
is the variance of Y, where 𝜎𝜎 2 = 𝜎𝜎𝑢𝑢2 + 𝜎𝜎𝑒𝑒2 .

𝐾𝐾0,0

is the number of level-2 units for which X = 0 and Z = 0.

𝐾𝐾1,0

is the number of level-2 units for which X = 1 and Z = 0.

𝑀𝑀

is the average number of level-1 units per level-2 unit.

𝐾𝐾1,1

is the number of level-2 units for which X = 1 and Z = 1.

The test of significance of the product XijZij term in the mixed model analysis is the test statistic of interest. It tests
whether the difference between the two levels of one factor at the high level of the other factor is equal to the
corresponding difference at the low level of the second factor.
Assume that 𝛿𝛿𝑋𝑋𝑋𝑋(2) is to be tested using a Wald test. The statistical hypotheses are 𝐻𝐻0 : 𝛿𝛿𝑋𝑋𝑋𝑋(2) = 0 vs. 𝐻𝐻𝑎𝑎 : 𝛿𝛿𝑋𝑋𝑋𝑋(2) ≠
0.

The power is calculated using

⎧
⎫
⎪𝛿𝛿𝑋𝑋𝑋𝑋(2)
⎪
𝑀𝑀
− Φ(1 − 𝛼𝛼/2)
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 = Φ
⎨ 𝜎𝜎 �𝑓𝑓 � 1 + 1 + 1 + 1 �
⎬
⎪
⎪
𝐾𝐾0,0 𝐾𝐾1,1 𝐾𝐾1,0 𝐾𝐾0,1
⎩
⎭

where 𝑓𝑓 = 1 + (𝑀𝑀 − 1)𝜌𝜌.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are δ (Interaction), Power, K00, and M.
Under most situations, you will select either Power to calculate power or K00 to calculate the number of level-2
units. Occasionally, you may want to fix the number of level-2 units and find the necessary average number of
level-1 units.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers integer
values of K00 and M only.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

370-3
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Mixed Models Tests for Interaction in a 2×2 Factorial 2-Level Hierarchical Design (Level-2 Randomization)

Sample Size – Number of Level-1 and Level-2 Units
K00 (Group 00 Count (X=0, Z=0))
This is the number of level-2 units (e.g., classes) in group 00, which we have designated as the group in which
both of the binary factors X and Z are zero (i.e., control group). The total sample size for this group is equal to the
number of level-2 units times the average number of level-1 (e.g., students) units per level-2 unit.
Each of the factors X and Z has two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 0
and Z = 0, neither of the interventions occur. Hence this is the control group.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K01 (Group 01 Count (X=0, Z=1))
This is the number of level-2 units (e.g., classes) in group 01, which we have designated as the group in which X
is zero and Z is one (i.e., only Z is active). The total sample size for this group is equal to the number of level-2
units times the average number of level-1 units per level-2 unit.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 0
and Z = 1, an intervention occurs for Z but not X.
Using Multiples of K00
If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If
you want to use K00 directly, you do not have to enter a leading "1".
For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.
List
You can use a list of values such as "10 20 30" or "K00 2K00 3K00".
K10 (Group 01 Count (X=1, Z=0))
This is the number of level-2 units (e.g., classes) in group 10, which we have designated as the group in which X
is one). The total sample size for this group is equal to the number of level-2 units times the average number of
level-1 units per level-2 unit.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 1
and Z = 0, an intervention occurs for X but not Z.
Using Multiples of K00
If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If
you want to use K00 directly, you do not have to enter a leading "1".
For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.
List
You can use a list of values such as "10 20 30" or "K00 2K00 3K00".
K11 (Group 11 Count (X=1, Z=1))
This is the number of level-2 units (e.g., classes) in group 11, which we have designated as the group in which X
is one and Z is one. The total sample size for this group is equal to the number of level-2 units times the average
number of level-1 units per level-2 unit.
Each of the factors X and Z have two levels: 0 (no intervention) and 1 (intervention). In this group in which X = 1
and Z = 1, an intervention occurs for both factors.
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Using Multiples of K00
If you simply want a multiple of the value for group 00, enter the multiple followed by "K00", with no blanks. If
you want to use K00 directly, you do not have to enter a leading "1".
For example, all of the following are valid entries: 10K00 2K00 0.5K00 K00.
List
You can use a list of values such as "10 20 30" or "K00 2K00 3K00".
M (Level-1 Unit Count Per Level-2 Unit)
This is the average number of level-1 units (e.g., subjects) per level-2 unit (e.g., class) in all four groups.
This value must be a positive number that is at least 1. It can be a decimal (fractional) number such as '2.7'.
List
You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.

Effect Size
δ (Interaction = (μ11 - μ10) - (μ01 - μ00))
Enter a value for the interaction among the four group means at which the study is to be powered. That is, the
power is the probability of detecting a difference of at least this amount. This value is not necessarily the true
interaction difference. Rather, it is the interaction difference that you want to be able to detect.
Interaction
The interaction is the difference of the differences. That is, it is constructed as the difference between the two
differences (μ11 - μ10) and (μ01 - μ00). It is the failure of the two factors to act independently of each other.
δ can be any non-zero value (positive or negative). Since this procedure uses a two-sided test statistic, you will get
the same result with either positive or negative values.
Syntax
You can enter a single value such as 10 or a series of values such as 10 20 30 or 5 to 50 by 5. When a series of
values is entered, PASS will generate a separate calculation result for each value of the series.
σ (Standard Deviation)
Enter the subject-to-subject standard deviation. This standard deviation applies for all groups.
Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7
9 or 1 to 9 by 2.
Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.
ρ (Intraclass Correlation, ICC)
This is the value of the intraclass (or intracluster) correlation coefficient. It may be interpreted as the correlation
between any two level-1 observations from the same level-2 unit.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.
You may enter a single value or a list of values.
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Example 1 – Calculating Power
Suppose that a two-level hierarchical design is planned in which there will be two interventions. Each intervention
will be whether one of two drugs is administered. There will be only one measurement per subject and the four
treatments will be applied to whole clusters (level-two units). The analysis will be a mixed model of continuous
data using the model given earlier in this chapter. The following parameter settings are to be used for the power
analysis: δ = 7; σ = 9.7; ρ = 0.06; M = 5 or 10; α = 0.05; and K00 = K01 = K10 = K11 = 5 to 20 by 5. Find the
power of each combination of parameter settings.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-2 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... Power
Alpha .............................................................. 0.05
K00 (Group 00 Count (X=0, Z=0)) ................. 5 10 15 20
K01 (Group 01 Count (X=0, Z=1)) ................. K00
K10 (Group 10 Count (X=1, Z=0)) ................. K00
K11 (Group 11 Count (X=1, Z=1)) ................. K00
M (Level-1 Unit Count Per Level-2 Unit)........ 5 10
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 7
σ (Standard Deviation) .................................. 9.7
ρ (Intraclass Correlation, ICC) ....................... 0.06

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.3670
0.5382
0.6298
0.8283
0.8013
0.9453
0.8998
0.9843

Total Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 2 Level 2 Level 2 Level 2
Count
Count
Count
Count
Count
N
K00
K01
K10
K11
100
5
5
5
5
200
5
5
5
5
200
10
10
10
10
400
10
10
10
10
300
15
15
15
15
600
15
15
15
15
400
20
20
20
20
800
20
20
20
20

Level 1
Count
M
5
10
5
10
5
10
5
10

Inter
Diff
δ
7.00
7.00
7.00
7.00
7.00
7.00
7.00
7.00

Std
Dev
σ
9.70
9.70
9.70
9.70
9.70
9.70
9.70
9.70

ICC
ρ
0.060
0.060
0.060
0.060
0.060
0.060
0.060
0.060

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Ahn, C., Heo, M., and Zhang, S. 2015. Sample Size Calculations for Clustered and Longitudinal Outcomes in
Clinical Research. CRC Press. New York.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units in the study.
K00 (Group 00 Count (F1=0, F2=0)) is the number of level-2 units in Group 00 (group in which F1 = 0 and F2 = 0).
K01 (Group 01 Count (F1=0, F2=1)) is the number of level-2 units in Group 01 (group in which F1 = 0 and F2 = 1).
K10 (Group 10 Count (F1=1, F2=0)) is the number of level-2 units in Group 10 (group in which F1 = 1 and F2 = 0).
K11 (Group 11 Count (F1=1, F2=1)) is the number of level-2 units in Group 11 (group in which F1 = 1 and F2 = 1).
M is the average number of level-1 units per level-2 unit.
δ is the interaction difference (μ11 - μ10) - (μ01 - μ00) at which the power is calculated.
σ is the standard deviation of the subject responses.
ρ (ICC) is the intraclass correlation among level-1 units within a single level-2 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements ─────────────────────────────────────────────────────────
A total sample size of 100 level-1 units, which were obtained by sampling 5 level-2 units in
group 00, 5 level-2 units in group 01, 5 level-2 units in group 10, and 5 level-2 units in
group 11 with an average of 5 level-1 units per level-2 unit, achieve 37% power to detect an
interaction difference among the group means of at least 7.00. The standard deviation of
subjects is 9.70. The intraclass correlation coefficient is 0.060. A test based on a
mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power for the various parameter settings.
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Example 2 – Calculating Sample Size (K00)
Continuing with the last example, suppose the researchers want to determine the value of K00 needed to achieve
90% power for both values of M.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-2 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K00 (Group 00 Count of Level-2 Units)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
K01 (Group 01 Count (X=0, Z=1)) ................. K00
K10 (Group 10 Count (X=1, Z=0)) ................. K00
K11 (Group 11 Count (X=1, Z=1)) ................. K00
M (Level-1 Unit Count Per Level-2 Unit)........ 5 10
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 7
σ (Standard Deviation) .................................. 9.7
ρ (Intraclass Correlation, ICC) ....................... 0.06

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.9131
0.9123

Total Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 2 Level 2 Level 2 Level 2
Count
Count
Count
Count
Count
N
K00
K01
K10
K11
420
21
21
21
21
520
13
13
13
13

Level 1
Count
M
5
10

Inter
Diff
δ
7.00
7.00

Std
Dev
σ
9.70
9.70

ICC
ρ
0.060
0.060

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 170 provide a table in which several scenarios are reported. We will validate
this procedure by duplicating the top entry. The following parameter settings are used for the power analysis:
Power = 0.80; δ = 0.4; σ = 1; ρ = 0.1; M = 10; and α = 0.05. The reported value of K00, K01, K10, K11 is 38 and
the attained power at 0.807.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Interaction in a 2×2 Fact. 2-Level Hier. Design (Level-2 Rand.)
procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to
the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... K00 (Group 00 Count of Level-2 Units)
Power ............................................................. 0.80
Alpha .............................................................. 0.05
K01 (Group 01 Count (X=0, Z=1)) ................. K00
K10 (Group 10 Count (X=1, Z=0)) ................. K00
K11 (Group 11 Count (X=1, Z=1)) ................. K00
M (Level-1 Unit Count Per Level-2 Unit)........ 10
δ (Interaction = (μ11 - μ10) - (μ01 - μ00)) ..... 0.4
σ (Standard Deviation) .................................. 1
ρ (Intraclass Correlation, ICC) ....................... 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Interaction in a 2×2 Factorial ────────────────────────────────────

Power
0.8074

Total Grp(0,0) Grp(0,1) Grp(1,0) Grp(1,1)
Level 1 Level 2 Level 2 Level 2 Level 2
Count
Count
Count
Count
Count
N
K00
K01
K10
K11
1520
38
38
38
38

Level 1
Count
M
10

Inter
Diff
δ
0.40

Std
Dev
σ
1.00

ICC
ρ
0.100

Alpha
0.050

PASS also calculates the value of K00 to be 38 and the power at 0.8074.
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